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Late-Breaking News 
About Compressor 2

 

This document provides updated information about Compressor 2 and covers 
these topics: 
Â

 

Late-Breaking News About Compressor 2.3.1 (p. 2)
Â

 

Previous Release Information About Compressor 2.3 (p. 2)
Â

 

Corrections to the Compressor 2 User Manual (p. 6)
Â

 

Previous Release Information About Compressor 2.1 (p. 13)
Â

 

Previous Release Information About Compressor 2.0.1 (p. 19)
Â

 

Previous Release Information About Compressor 2.0 (p. 20)

This document may be updated as versions of Compressor are released or new 
information becomes available. You can check for updated information by choosing 
Help > Late-Breaking News when Compressor is open.

For the latest information about product updates, tips and techniques, and qualified 
third-party devices, choose Compressor Support from the Compressor Help menu or 
visit the Compressor support website at http://www.apple.com/support/compressor.

To receive automatic notification about new support issues, use Safari to bookmark the 
AppleCare RSS page at http://docs.info.apple.com/rss/compressor.rss. See Safari Help 
for more information about configuring RSS feeds.

There is no late-breaking information about Compressor 2.2, which was not released 
to the public.

http://www.apple.com/support/compressor
http://docs.info.apple.com/rss/compressor.rss.
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Late-Breaking News About Compressor 2.3.1

 

Compressor 2.3.1 addresses compatibility issues. This update is recommended 
for all Compressor 2.3 users.

 

Mac OS X v10.5 Leopard Support

 

Compressor 2.3.1 addresses Mac OS X v10.5 compatibility issues for customers 
using Compressor 2.3.

 

Using Compressor Distributed Processing with Mac OS X Server v10.5

 

To use the Compressor distributed processing feature with Mac OS X Server v10.5 
Leopard, you must manually enable NFS.

 

To enable NFS for Mac OS X Server, do one of the following:
m

 

Use the Server Admin application to enable NFS. For additional information, see 
Mac OS X Server Help.

m

 

In the command line, enter the following:

 

qmaster$ sudo nfsd enable

 

Previous Release Information About Compressor 2.3

 

Compressor 2.3 addresses performance issues and improves stability. This update is 
recommended for all Compressor 2.1 users.

 

iPod Video Support

 

Compressor 2.3 adds compatibility with new options for transcoding to iPod-compliant 
H.264 files. This section contains detailed information about the various controls within 
the H.264 for iPod Encoder pane of the Inspector window. The information in this 
section replaces information that was released with Compressor 2.1 about the H.264 
for iPod Encoder pane.
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You make your H.264 for iPod settings using the controls described below, either by 
duplicating an existing setting and modifying it or by creating a new setting in the 
Settings tab of the Presets window. The H.264 for iPod Encoder pane contains the 
following items:
Â

 

Extension:  

 

This field displays the H.264 for iPod file extension (.m4v

 

) 

 

automatically 
after the H.264 for iPod output format is chosen from the File Format pop-up menu 
or the ( + ) pop-up menu in the Settings tab of the Presets window.

Â

 

Allow Job Segmenting: 

 

 This checkbox allows you to turn off job segmenting. It is 
relevant only if you are using Compressor with distributed processing 

 

and

 

 with 
multi-pass encoding. (The Compressor 2 distributed processing feature is limited to 
computers that have either Final Cut Studio or DVD Studio Pro 4 installed.) For more 
information, see “Encoder Pane” on page 43 of the 

 

Compressor 2 User Manual

 

.
Â

 

Size:  

 

Select one of the following size options: 
Â

 

640 (VGA):

 

  This option creates video output files with a frame width of 640 pixels.
Â

 

320 (QVGA):

 

  This option creates video output files with a frame width of 320 pixels.
Â

 

Aspect Ratio: 

 

 Use the Aspect Ratio pop-up menu to choose the exact pixel 
dimensions of the output media file. The available options depend on which size 
option (640 or 320) you selected.

The following choices are available in the Aspect Ratio pop-up menu:

 

640 (VGA) 320 (QVGA)

 

4:3 (640 x 480) 4:3 (320 x 240)

16:9 (640 x 360) 16:9 (320 x 180)

1.85:1 (640 x 346) 1.85:1 (320 x 173)

2.35:1 (640 x 272) 2.35:1 (320 x 136)

Automatic Automatic 
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If the source media file is either DV NTSC or HDV, but you are unsure of your source 
media file’s aspect ratio, choose Automatic. This option analyzes the source media file’s 
aspect ratio to determine the appropriate pixel dimensions.

 

Note:  

 

By default, the Frame Controls feature is set to Automatic. As in the H.264 for 
DVD Studio Pro setting, the Frame Controls Retiming Control will be engaged only if 
the source file is interlaced.

Â

 

Frame Rate:  

 

Use this pop-up menu to choose from the following six choices:
Â

 

29.97
Â

 

25
Â

 

24
Â

 

23.98
Â

 

15
Â

 

Automatic:

 

  Choose this setting if you are unsure of your source media file’s video 
format. This setting analyzes your source media file’s frame rate to determine the 
correct video format.

 

Using QuickTime Export Components for iPod Video

 

If the frame rate of your video is less than 12 fps, or the frame size is smaller than 
320 x 240, you can use the QuickTime Export Components method of transcoding to 
iPod-compliant H.264 files. For more information, see “Creating QuickTime Export 
Component Output Files” on page 177 of the 

 

Compressor 2 User Manual

 

. Distributed 
processing and Frame Controls are not available with the QuickTime Export Components 
method, so if you need to use this method, consider a “preprocessing” pass with Frame 
Controls to an intermediate file using the Uncompressed 8-Bit 4:2:2 format. Then use the 
QuickTime Export Components method for the final encoding step.
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Â

 

Bit Rate:  

 

Use this slider to choose the bit rate to use for the output video, or enter a 
number in the text field. The available ranges are from 1000 to 1500 kbps for 640 (VGA) 
files and 300 to 700 kbps for 320 (QVGA) files. The setting you should choose depends 
on how the output is to be used. Higher bit rates produce better picture quality, but 
they also produce larger output files. Except for the 700 kbps single-pass encoding 
option for 320 (QVGA) files, all encoding for iPod-compliant H.264 files is multi-pass.

Â

 

Frame Sync:

 

  Also known as the 

 

key frame interval

 

, the Frame Sync value represents how 
often a keyframe is inserted in the H.264 stream. The lower the number, the more 
smoothly the video can be manipulated (scrubbed) during playback (more frequent 
keyframes). The higher the number, the more efficient the compression (less frequent 
keyframes). The available range is from 2 to 10 seconds; the default is 5 seconds. 

 

To adjust the Frame Sync value, do one of the following:
m

 

Use the slider to choose the frame sync (keyframe) rate for the output video, or enter a 
number in the text field. 

m

 

Select Automatic to allow Compressor to set the frame sync (keyframe) rate.

Â

 

Multi-pass:

 

  Similar to two-pass MPEG-2 encoding, multi-pass offers the best possible 
quality. For faster (single-pass) encoding for 320 (QVGA) files only, turn this feature off 
by deselecting the checkbox. (Single-pass is disabled unless QuickTime 7.0.4 or later 
is installed.)

 

Note:  

 

If you are also using distributed processing, you may want to turn off job 
segmenting. (See “Allow Job Segmenting” on

 

 

 

page 3.) For more information, see “Job 
Segmenting and Multi-pass” on page 112 of the 

 

Compressor 2 User Manual

 

.

Â

 

Include AAC Audio:

 

  Use this checkbox to include a stereo AAC audio track in the 
output movie. The audio track will have a bit rate of 128 kbps. The sample rate will 
be either 44.1 kHz or 48 kHz, depending on the input audio.
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Chapter Markers for iPod and QuickTime Output

 

In previous versions of Compressor, you could add and name chapter markers that 
DVD Studio Pro would recognize in MPEG-1, MPEG-2, and H.264 for DVD Studio Pro 
output files. Compressor 2.3 expands this feature for iPod video authoring and other 
QuickTime authoring. Chapter markers are now passed through (transferred) to other 
output files that can be recognized by QuickTime Player, iTunes (.m4v files), 
Final Cut Pro, and DVD Studio Pro. For information about adding chapter markers, see 
“Adding Chapter Markers to a Clip” on page 222 of the 

 

Compressor 2 User Manual

 

.

 

Deinterlacing with Frame Controls

 

Compressor 2.3 addresses issues with deinterlacing quality for the fastest Frame 
Controls settings, specifically for the following conditions:
Â

 

An interlaced source media file
Â

 

Frame Controls Resize Filter:

 

  Better (Linear filter)
Â

 

Frame Controls Output Fields:

 

  Progressive
Â

 

Frame Controls Deinterlace:

 

  Fast or Better
Â

 

Frame Controls Adaptive Details:

 

  Off (not selected)
Â

 

Frame Controls Rate Conversion:

 

  Fast (Nearest frame)

 

Note:  

 

This improvement requires Mac OS X 10.4.7.

 

Corrections to the Compressor 2 User Manual

 

The following information covers corrections and updates to the documentation 
included with Compressor 2.

 

Command Line Syntax

 

The command line syntax in the synopsis example at the bottom of page 246 of the 

 

Compressor 2 User Manual

 

 is incorrect. Here is the correct example:

 

Compressor [-clustername <name>]

[-clusterid <username:password@ipaddress:portNumber>] [-batchfilepath 

<path>] [-batchname <batchname>] [-priority <value>] [-jobpath <path>] 

[-settingpath <path>] [-destinationpath <path>] [-info <xml>] 

[-timeout <seconds>] [-help] [-show]

 

In this example,

 

 -jobpath, -settingpath, 

 

and

 

 -destinationpath 

 

can be repeated 
as many times as the number of jobs you want to submit.

 

Note:  

 

Not all of the options are necessary. For example, you can specify the cluster 
either by its 

 

-clustername

 

 

 

or

 

 by its 

 

-clusterid

 

. You do not need to specify both. If both 
are specified, only 

 

-clusterid

 

 is used.
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Additionally, if you specify

 

 -batchfilepath, 

 

then

 

 -jobpath, -settingpath, 

 

and

 

 

-destinationpath 

 

are not necessary because the previously saved batch file already 
contains information about the job, settings, and destination.

Example of

 

 -batchfilepath:

Compressor -clustername "This Computer" -batchfilepath "/Volumes/Hermione/

SavedCompressorBatches/FreeChampagne.compressor"

 

Surround Sound Channel Identifier Codes

 

The section on page 104 entitled “Assigning Files to Surround Sound Channels 
(Automatic Methods)” contains inaccurate instructions. In order to create a single 
surround source media file in the Batch window with this automatic method, you must 
use the following channel identifier codes:

For example, to assign an AIFF file to the left surround channel, rename the file as 
filename-RL.aiff (where filename is the name of your file).

 

Note:  

 

This procedure only works when you drag and drop files into the Batch window. 
If you drag the files onto the application icon, they will appear as separate sources.

 

About the Frame Controls Pane 

 

The following is an update of the “Working With Frame Controls” section on pages 
196–199 of the 

 

Compressor 2 User Manual

 

. Use the features in the Frame Controls pane 
of the Inspector to select and adjust Frame Controls attributes that you want to assign 
to your settings.

 

Channel assignment Channel Identifier Code

 

Left front channel -L

Right front channel -R

Center front channel -C

Left surround channel -RL

Right surround channel -RR

Center surround channel -RC

Low frequency channel 
(Subwoofer, LFE)

-LFE
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Frame Controls

 

Use this pop-up menu to choose from the following Frame Controls options:

Â

 

Off:  

 

The default setting for most Apple presets. 

 

Choose Off if your Compressor project 
does not involve changes to the frame size, frame rate, or field dominance.

Â

 

Automatic:  

 

Compressor analyzes the transcoding job (the source media file and 
the applied setting), and then automatically determines the appropriate Frame 
Controls attributes.
In Automatic mode, Frame Controls technology is engaged in the following two 
types of transcodes only:

Â

 

Transcoding from high definition (HD) sources to standard definition (SD) MPEG-2 
output files

Â

 

Transcoding from interlaced sources to H.264 for DVD Studio Pro (progressive) 
output files

Â

 

Custom:  

 

Allows you to manually adjust all of the attributes in the Frame Controls pane.

 

Resizing Control

 

Use the controls in this section to choose the algorithm with which frames are resized. 

Â

 

Resize Filter:  

 

Use this pop-up menu to choose from the following resizing options. 
This decision is a trade-off between faster processing time and higher output quality 
in projects that involve a change in resolution.
Â Fast (Nearest pixel)
Â Better (Linear filter)
Â Best (Statistical prediction)
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Â Output Fields:  Use this pop-up menu to choose the output scanning method (either 
the field dominance or a conversion to progressive scanning). 
Â Same as source:  No change to the scanning method.
Â Progressive:  Scanning method where each frame is complete (not divided into 

fields). Use this setting in place of the Compressor Deinterlacing filter (a legacy 
filter in the Filters pane) as it will always provide much higher quality. 

Â Top first:  Interlaced field dominance (field order), also known as field two, the upper 
field, or the odd field.

Â Bottom first:  Interlaced field dominance (field order), also known as field one, the 
lower field, or the even field.

Â Deinterlace:  Use this pop-up menu to choose from different techniques for 
deinterlacing. This decision is a trade-off between faster processing and 
higher-quality deinterlacing of motion areas within the frame. In all cases, each 
higher-quality deinterlacing option yields the same or better results than the next 
lower quality option. However, if downward resizing is also applied to the frame, 
improvements in quality may not be noticeable. Under these circumstances, Fast or 
Better will likely provide sufficiently high quality, depending on the amount of 
downward resizing.
Â Fast (Line averaging):  This option averages adjacent lines in a frame.
Â Better (Motion adaptive):  This option offers good-quality deinterlacing for areas of 

the image that are in motion.
Â Best (Motion compensated):  This option offers higher-quality deinterlacing for areas 

of the image that are in motion.

While the Deinterlace pop-up menu is always active, Compressor only deinterlaces jobs 
that need it. (For example, if the source is interlaced and the Output Fields pop-up 
menu is set to Progressive, Compressor will deinterlace. If the source media file is 
progressive, Compressor will not deinterlace.) 

Warning:  Using all Best settings may result in unexpectedly long processing times. If 
you are reducing the frame size in addition to deinterlacing the frame, Fast or Better will 
likely provide sufficiently high quality, depending on the amount of downward resizing.
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Adaptive Details, Anti-Alias, and Details Level
Use the following controls to make frame resizing adjustments.

Â Adaptive Details:  Select this checkbox to use advanced image analysis to distinguish 
between noise and edge areas. 

Â Anti-alias:  Use this slider to set a softness level from 0 to 100. This parameter 
improves the quality of conversions when you’re scaling media up. For example, 
when transcoding standard definition video to high definition, Anti-alias smooths 
out jagged edges that might appear in the image. 

Â Details Level:  Use this slider to set a level (from 0 to 100) to preserve sharp edges. 
This is a sharpening control that lets you add detail back to an image being enlarged. 
Unlike other sharpening operations, the Details Level setting is able to distinguish 
between noise and feature details, and generally doesn’t increase unwanted grain. 
Increasing this parameter may introduce jagged edges, however, which can be 
eliminated by increasing the Anti-alias level. 

Note:  Adaptive Details, Anti-alias, and Details Level pertain only to frame resizing 
(scaling), not deinterlacing.

Retiming Control
Use the controls in this section to choose the algorithm with which frame rates 
are adjusted. 
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Â Rate Conversion:  Use this pop-up menu to choose from the following techniques for 
retiming frames (changing the frame rate). This decision is a trade-off between faster 
processing time and higher output quality. In many cases, the Better setting will 
provide sufficiently high-quality conversion at a substantial savings in processing 
time over the Best setting.
Â Fast (Nearest frame):  No frame blending is applied; Compressor simply uses a copy 

of the nearest available frame to fill the new in-between frames.
Â Good (Frame blending):  Averages neighboring frames together to create new 

in-between frames.
Â Better (Motion compensated):  Uses optical flow to interpolate frames, with 

good-quality results.
Â Best (High quality motion compensated):  Uses optical flow to interpolate frames, 

with higher-quality results; this option is particularly useful for transcodes that 
involve increases in frame rates (for example, 23.98 fps to 59.94 fps).

Adding Frame Controls to a Setting
You use the Frame Controls pane in the Inspector window to add frame resizing and 
retiming adjustments to your settings. 

To add automatic Frame Controls adjustments to a setting:
1 Open the Settings tab of the Presets window.

2 Select the setting in the Settings table that you want to modify. (Or select a setting 
already applied to a source media file in the Batch window.)

3 Click the Frame Controls tab in the Inspector.

4 Choose Automatic from the Frame Controls pop-up menu.

Compressor analyzes the transcoding job (the source media file and the applied 
setting), and then automatically determines the appropriate Frame Controls attributes.

In Automatic mode, Frame Controls technology is engaged in the following two types 
of transcodes only:
Â Transcoding from high definition (HD) sources to standard definition (SD) MPEG-2 

output files
Â Transcoding from interlaced sources to H.264 for DVD Studio Pro (progressive) 

output files

Warning:  Using all Best settings may result in unexpectedly long processing times. 
The Better setting for rate conversion will provide sufficiently high-quality conversion 
at a substantial savings in processing time over the Best setting.
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To add custom Frame Controls adjustments to a setting:
1 Open the Settings tab of the Presets window.

2 Select the setting in the Settings table that you want to modify. (Or select a setting 
already applied to a source media file in the Batch window.)

3 Click the Frame Controls tab in the Inspector.

4 Choose Custom from the Frame Controls pop-up menu.

Choosing Custom allows you to manually adjust all of the attributes in the Frame 
Controls pane.

5 Make changes to any of the following controls in the Frame Controls pane. (See “About 
the Frame Controls Pane” on page 7 for details on each of the controls.)

Â Resize filter
Â Deinterlace
Â Adaptive Details
Â Anti-alias
Â Details Level
Â Rate Conversion

6 Click Save to save the changes.

Standards Conversion with Frame Controls
With the Frame Controls feature, you can convert video files between international 
television standards (such as PAL to NTSC or NTSC to PAL) at levels of quality that were 
previously only available through expensive hardware solutions. 

To convert a file to a different international television standard:
1 Add the source media file to the Batch window.

2 Open the Settings tab of the Presets window and find the appropriate target setting or 
create a custom setting.

Note:  The Advanced Format Conversions settings group contains many common 
settings for international television standards (such as DV NTSC or DVCPRO50 PAL).

3 Apply the setting to the source media file in the Batch window.

4 Click the Frame Controls tab in the Inspector.

5 Choose Custom from the Frame Controls pop-up menu.

Choosing Custom allows you to manually adjust all of the attributes in the Frame 
Controls pane.

6 Make changes to any of the controls in the Frame Controls pane. (See “About the 
Frame Controls Pane” on page 7 for details on each of the controls.)

7 Click Save As at the bottom of the Inspector window to save the changes.

8 Click Submit in the Batch window to have Compressor convert the file.
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Source Media File Data
Page 129 of the Compressor 2 User Manual includes instructions on how to get 
information about a source media file:

To see the source media resolution and frame rate: 
1 Import the source media file into the Batch window. 

2 Click the source’s name in the Batch window. 

The subsequent sentence should have read as follows:

The source media file’s resolution, frame rate, and duration appear in the Inspector 
window as well as at the bottom of the Preview window. 

Previous Release Information About Compressor 2.1
This version of Compressor is designed to run natively on both PowerPC-based and 
Intel-based Macintosh computers.

iPod Video Support
Compressor 2.1 adds professional “H.264 for iPod” settings for transcoding to 
iPod-compliant H.264 files. These settings can be used with the distributed processing 
and Frame Controls features. The “Create a New Setting” ( + ) pop-up menu in the 
Settings tab of the Presets window now includes an “H.264 for iPod” menu item.

The Apple group of factory settings in the Settings tab of the Presets window now 
includes an “iPod Video” setting.
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Bit Rate Adjustment in H.264 Encoder Pane
Compressor 2.1 adds additional controls in the H.264 for DVD Studio Pro Encoder pane 
of the Inspector window for adjusting the bit rate of H.264 files intended for authoring 
high definition (HD) format video DVDs. The new Maximum Bit Rate slider and field 
provide more precise encoding control. The former Bit Rate slider and field have been 
re-named to Average Bit Rate.
Â Average Bit Rate slider and field:  Choose an average bit rate to use for the output 

video with the slider, or enter a value directly. While the available range is between 
0.5 and 24.99 Mbps, typical HD-based DVD video bit rates with H.264 might range 
from 7 to 15 Mbps, depending on your DVD bit-budget and the nature of your source 
media files. The H.264 file format is twice as efficient as the standard MPEG-2 format. 
This means you can count on a lower bit rate to get the same quality, or higher 
quality at the same bit rate.

Â Maximum Bit Rate slider and field:  Choose a maximum bit rate between .59 Mbps and 
29.4 Mbps. You can also enter any number within these ranges into the accompanying 
field. The Maximum Bit Rate cannot be set lower than the Average Bit Rate.

Important:  When determining average and maximum bit rates for DVD playback, 
remember to consider the bit rate of your audio tracks as well as the H.264 bit rate. You 
must keep the total of both average and maximum audio and video bit rates under 
30 Mbps, the maximum guaranteed transfer rate from high definition DVD players. 

(Because DVD-compatible audio formats are constant bit rate (CBR), there is no 
maximum audio bit rate to worry about.) For example, if you are using AIFF audio at 
1.5 Mbps, you should keep both the average and maximum video bit rates for high 
definition DVDs under 28.5 Mbps. Typically, your average bit rate will be lower than this 
(from 7 to 15 Mbps). However, your maximum bit rate must also stay under this 
number. The 28.0 Mbps maximum bit rate is recommended to provide an extra margin 
for error (for example, to accommodate subtitle streams). If you are using one of the 
DVD-compatible compressed audio formats such as Dolby Digital or MPEG-1/Layer-2, 
your audio bit rate may be as low as 0.2 to 0.4 Mbps, in which case you can set your 
maximum bit rate about 1 Mbps higher. As a general rule, set your maximum bit rate at 
least 1 Mbps higher than your average bit rate, to allow for bit rate variability in 
achieving the goal of constant quality.
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Distributed Processing and QuickTime Versions
If you are using the Apple Qmaster distributed processing system with Compressor, all 
nodes (computers) in a cluster must have the same version of QuickTime installed. 

To download the most recent version of QuickTime, go to:
Â http://www.apple.com/quicktime/download/mac.html

Exporting from Final Cut Pro and Distributed Processing
You can use Compressor to transcode sequences or clips from within other 
applications, such as Final Cut Pro. This saves time and hard disk space by eliminating 
the need to export self-contained media files before processing them. 

There are two methods you can use to avoid exporting self-contained media files for 
Compressor distributed processing:
Â Export a sequence directly from Final Cut Pro to Compressor and then submit that 

job to a cluster in an Apple Qmaster distributed processing network. In this workflow, 
Final Cut Pro opens on each processing node in that cluster to complete the job. 

Â Export the Final Cut Pro sequence as a QuickTime reference movie and then submit 
the resulting movie to the cluster for processing. Although this method does not 
require that Final Cut Pro be installed on each computer in the distributed 
processing cluster, the media files specified in the reference movie must be available 
to each computer in the cluster.

To export a Final Cut Pro sequence directly to Compressor for distributed processing:
1 Make sure Final Cut Pro is installed on each computer in the cluster that you intend to 

use for distributed processing. 

Each installation of Final Cut Pro requires a product serial number. For information 
about volume licenses, go to http://www.apple.com/finalcutstudio.

2 Make sure all of the source media files and render files for your Final Cut Pro project are 
on a hard disk that can be shared (mounted) by all the computers in the cluster that 
will process the job. (The following instructions use an example of a shared hard disk 
named Media1.) 

If you copy all the media files to another hard disk for this purpose, you may need to 
reconnect the media files in Final Cut Pro before proceeding.

Important:  The hard disk you use to store the media files may not be a startup disk for 
any computer in the cluster.

http://www.apple.com/quicktime/download/mac.html
http://www.apple.com/finalcutstudio
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3 In Final Cut Pro, set the scratch disk to the same hard disk used for storing media files 
in step 2:

a Choose Final Cut Pro > System Settings, then click the Scratch Disks tab.
b Click Set. 
c In the dialog that appears, locate and select the disk you want to use (Media1 in 

this example).
d Click Choose. The specified disk (Media1) is listed next to the Set button, along with 

the amount of available disk space.
For more information about Final Cut Pro scratch disks, see the Final Cut Pro User Manual.

4 Enable file sharing on the computer where the scratch disk (Media1) is located (in the 
Sharing pane of System Preferences, click Services and then select Personal File Sharing).

5 On each computer in the intended cluster, mount the scratch disk you specified in 
step 3 (in the Finder sidebar, click Network, navigate to the computer that contains the 
Media1 disk, click Connect, and select Media1).

6 In Compressor preferences, specify cluster options settings:

a Choose Compressor > Preferences, or press Command-comma ( , ). The Preferences 
window appears.

b Choose Copy Source to Cluster as Needed from the Cluster Options pop-up menu.

7 In Final Cut Pro, choose File > Export > Using Compressor.

Compressor opens with the selected media file (the Final Cut Pro sequence) in the 
Batch window. 

8 In Compressor, double-click the selected file and play it in the Preview window to verify 
the integrity of the clip.

9 In the Batch window, assign settings and destinations to the selected file as necessary. 

10 Choose the intended cluster from the Cluster pop-up menu in the lower-left corner of 
the Batch window.

11 Click Submit.
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To export a Final Cut Pro sequence as a QuickTime reference movie and submit it to 
Compressor for distributed processing:

1 Make sure all of the source media files and render files for your Final Cut Pro project are 
on a hard disk that can be shared (mounted) by all the computers in the cluster that 
will process the job. (The following instructions use an example of a shared hard disk 
named Media1.) 

If you copy all the media files to another hard disk for this purpose, you may need to 
reconnect the media files in Final Cut Pro before proceeding.

Important:  The hard disk you use to store the media files may not be a startup disk for 
any computer in the cluster.

2 In Final Cut Pro, choose File > Export > QuickTime Movie.

3 In the Save dialog, make sure that the Make Movie Self-Contained checkbox is not 
selected.

4 Save the QuickTime reference movie to the same hard disk (Media1) used to store 
media files in step 1.

5 Enable file sharing on the computer where the scratch disk (Media1) is located (in the 
Sharing pane of System Preferences, click Services and then select Personal File Sharing).

6 On each computer in the intended cluster, mount the hard disk (Media1) where the 
media files and QuickTime reference movie are located (in the Finder sidebar, click 
Network, navigate to the computer that contains the Media1 disk, click Connect, and 
select Media1).

7 In Compressor preferences, specify cluster options settings:

a Choose Compressor > Preferences, or press Command-comma ( , ). The Preferences 
window appears.

b Choose Never Copy Source to Cluster from the Cluster Options pop-up menu. 

8 Import the QuickTime reference movie into Compressor. (Drag it from the desktop to 
the Compressor Batch window.)

9 Double-click the file in the Batch window and play it in the Preview window to verify 
the integrity of the clip.

10 In the Batch window, assign settings and destinations to the selected file as necessary. 

11 Choose the intended cluster from the Cluster pop-up menu in the lower-left corner of 
the Batch window.

12 Click Submit.
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Cluster Settings for Extended Transcoding Sessions
If you are using Compressor 2.0 or later for distributed processing, and you anticipate a 
transcoding session that will last up to seven days or longer, you must make an 
adjustment in the Advanced section of the Apple Qmaster Preferences Pane. By default, 
temporary process files may remain on a cluster’s scratch location for seven days before 
they are automatically deleted. You can increase this value (the number of days) in the 
Apple Qmaster pane in System Preferences.

To extend the time process files remain on a cluster’s scratch location: 
1 On the cluster controller, open the Apple Qmaster pane in System Preferences.

2 If any Apple Qmaster services are enabled on this computer, click Stop Sharing to 
temporarily turn them off.

3 Click Advanced to open the Advanced pane.

4 In the Delete Files Older Than __ Days field, enter the number of days you expect the 
session to take, plus a day or two extra, just in case.

5 Click Setup to return to the Setup pane.

6 Click Start Sharing.

“Inherited” Settings Issue Resolved
In previous versions of Compressor 2, old settings from Compressor 1.x produced 
undesirable results. This issue has been resolved.

Using Frame Controls for Frame Rate Conversion
If you are using Compressor for frame rate conversion (retiming), be sure to engage 
Frame Controls for the most accurate results. After making this change in Frame 
Controls, you can save the setting for future frame rate conversion jobs.

To convert the frame rate of a file using Frame Controls:
1 Add the source media file to the Batch window.

2 Open the Settings tab of the Presets window and find the appropriate target setting or 
create a custom setting.

3 Apply the setting to the source media file in the Batch window.

4 Click the Frame Controls tab in the Inspector.

5 Choose Custom from the Frame Controls pop-up menu.

Choosing Custom allows you to manually adjust all of the attributes in the Frame 
Controls pane. (See “About the Frame Controls Pane” on page 7 for details on each of 
the controls.)

6 Click Save As at the bottom of the Inspector window to save the changes.

7 Click Submit in the Batch window to have Compressor convert the file.
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Note:  Standards conversion (converting video files between international television 
standards such as PAL to NTSC, or NTSC to PAL) almost always involves frame rate 
conversion. For more information, see “Standards Conversion with Frame Controls” on 
page 12.

Test Transcode Tip
Before committing to a long transcoding session, do a quick test with a small section of 
the source media file. If there is a problem (such as an incorrect setting, or a reference 
file that can’t find the files it is referencing) you can make the correction without losing 
a lot of time. Such tests also allow you to preview Frame Controls results that are not 
visible in the Preview window. For a quick way to select a small section of the source 
media file, see “Transcoding a Portion of the Clip with the Preview Window” in the 
Compressor 2 User Manual.

Note:  Make sure the test section is specific to the type settings you apply. For example, 
pick a high motion section if you’re doing frame rate or field order conversions with 
Frame Controls.

Using Apple Qmaster 2 with an NFS Server
By default, Apple Qmaster uses /etc/exports to define its Cluster Storage export. This 
can cause a conflict if you defined an NFS export in your local Netinfo database. When 
you enable a controller using Apple Qmaster 2 or later, Apple Qmaster will use 
/etc/exports, not entries defined in your Netinfo database. To work around this issue, 
either move the exports to /etc/exports, or move the controller to a computer that 
doesn’t export anything.

Previous Release Information About Compressor 2.0.1
Compressor 2.0.1 is a maintenance release of Compressor that provides improved reliability.

Droplet Reporting Delay 
A Droplet is a standalone preset created by Compressor, packaged into a 
drag-and-drop application and saved as an icon. When you drag source media files to a 
Droplet icon, they are automatically submitted for transcoding using the specified 
embedded settings. If you submit a large number of source media files (such as 200 or 
more) using a Droplet, there may be a delay of about 1 minute between the “Getting 
ready for processing” alert message and the dialog reporting that the job is being 
submitted. You can avoid this reporting delay by reducing the number of source files 
you submit at one time with a Droplet.
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Previous Release Information About Compressor 2.0
The following information is late-breaking news that was included with Compressor 2.0.

Estimated Total File Size
Compressor can now display the estimated total size of an output file before the job 
is processed. 

To see the estimated file size of an output file:
1 Open the Batch window.

2 Import a source file.

3 Assign a setting to the source file. 

4 Select the assigned setting in the Batch table.

5 Open the Summary pane of the Inspector window.

Note:  The estimated total file size is not available for all output formats.

Audio Passthrough
With the audio passthrough feature in Compressor 2, you can transcode the video in a 
QuickTime movie, and Compressor will copy the audio into the output movie without 
modifying it. An example of this might involve HD (high definition) files with 
multi-track audio that you want to convert to SD (standard definition) files without 
disturbing the audio tracks. 

To modify the video format of a media file without changing its audio:
m In the QuickTime Movie Encoder pane of the Inspector window, choose “Pass-through” 

in the pop-up menu next to the Audio Settings button.

Note:  If you export a sequence from Final Cut Pro to Compressor (File > Export > Using 
Compressor) and apply a setting with “Pass-through” selected, the audio portion of the 
setting will change to a PCM setting with the sequence’s setting and channel count, 
but with only a single track created on output. If you require audio passthrough for a 
Final Cut Pro sequence, export a QuickTime movie (File > Export > QuickTime Movie) 
and then import the movie into Compressor.

Source Media File Data
Previously, source media file information (such as frame size and frame rate) was 
displayed in the lower-left and lower-right corners of the Preview window. While this 
remains true, the following video information is now also available in the Inspector 
window: frame width, frame height, frame rate, starting timecode, duration, native field 
dominance. For audio files, the Inspector window shows the sample rate and the 
number of channels.
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Importing AIFF Files With the File Menu
Certain AIFF files created with Final Cut Pro or GarageBand cannot be imported by 
choosing Import from the File menu. To import these files, drag them to the Batch window.

Refreshing the Frame Size in the Preview Window
When you adjust the frame size of a setting (in the Geometry pane of the Inspector 
window) while you are viewing it in the Preview window, the frame size may not resize 
accordingly. If this occurs, close the Preview window and reopen it, and it will display 
the correct frame size.

Duration Display in the Preview Window
The way the Preview window displays the duration of a media file (in the lower-right 
corner of the window) has been enhanced. Compressor 2 always displays the duration 
between the In point and the Out point, regardless of whether the Preview window is 
in the Source view or the Setting view. To see the total duration of the clip (without In 
and Out points), select the source file in the Batch window and open the Inspector 
window (Window > Show Inspector).

Frame Controls and the Preview Window
Although Geometry (cropping and scaling) and Filters adjustments are displayed 
instantly in the Preview window, Frame Controls settings are not. To preview Frame 
Controls settings, do a test transcode of a small section of your source media file. (See 
“Transcoding a Portion of the Clip With the Preview Window” in the Compressor 2 
User Manual for more information.)

Creating MPEG-1 Layer 2 Audio Files
MPEG-1 audio provides a way to reduce audio file sizes and reduce the bit rate needed 
to play the files. For example, you can use MPEG-1 audio in conjunction with MPEG-2 
video on a DVD, which is useful when you want to maximize the amount of disc space 
and bit rate available for your project’s video. While there is no Apple setting for 
MPEG-1 audio-only files in this release of Compressor, you can easily create a setting 
yourself. See the Compressor 2 User Manual for detailed instructions on configuring the 
MPEG-1 output file format (for DVD or web use, and so on).

Adjusting Settings for QuickTime Export Component Output Files
Please note the following when using the QuickTime Export Component Output feature:
Â Use the third-party export module user interface to explicitly enter the width, height, 

and frame rate for the output file. Do not leave the width, height, and frame rate 
fields in the third-party user interface at their default (“Current”) values.

Â The Compressor Cropping and Frame Controls features are not available when using 
the QuickTime Export Component Output feature.
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Droplets and Compressor Processing Services 
When you drag source media files to a Droplet icon, they are automatically submitted 
for transcoding using the specified embedded settings. The transcoding process 
begins, whether or not the Compressor application is open. If you drag files to a 
Droplet icon without first opening the application or opening a Droplet, Compressor 
may display an alert message (“This computer is unavailable”), indicating that 
Compressor processing services have not yet started up in the background. Click 
Submit at the bottom of the Droplet window. Compressor processing services will start 
up and transcode the files.

TIFF Transcodes and Remote Destinations
You can use Compressor to convert a video clip to a TIFF image sequence for use with 
applications that are not compatible with QuickTime. However, the Compressor 
Remote Destination feature does not support uploading TIFF image sequences to a 
remote destination (FTP server). Instead, use FTP software to upload the TIFF image 
sequence to remote servers.

Creating H.264 Files for HD-DVD
To ensure that any H.264 files you create with Compressor will compile properly into 
HD-DVD–compliant files in DVD Studio Pro, make sure that multi-pass encoding is 
turned on. 

To turn on H.264 multi-pass encoding:
1 Open the Settings tab of the Presets window.

2 Select the setting in the Settings table that you want to modify. (Or select a setting 
already applied to a source media file in the Batch window.)

3 Open the H.264 Encoder pane in the Inspector window.

4 Select the Multi-pass checkbox.

Note:  If you turn on Multi-pass, and you are using Compressor with distributed 
processing, you may want to turn off job segmenting by deselecting the Allow Job 
Segmenting checkbox. For more information, see the Compressor 2 User Manual. (The 
Compressor 2 distributed processing feature is limited to computers that have either 
Final Cut Studio or DVD Studio Pro 4 installed.)
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Scaling (10-bit Color) Source Media Files
If you are using Compressor to transcode source media files which use 10 bits per color 
channel and you intend to scale (resize) the frame size, enable Frame Controls. If you 
do not enable Frame Controls in these cases, the transcoded output file will have 8-bit 
color rather than 10-bit color. 

To enable Frame Controls:
1 Open the Settings tab of the Presets window.

2 Select the setting in the Settings table that you want to modify. (Or select a setting 
already applied to a source media file in the Batch window.)

3 Click the Frame Controls tab in the Inspector window.

4 Choose one of the following from the Frame Controls pop-up menu:

Â Automatic:  Compressor analyzes the transcoding job (the source media file and 
the applied setting), and then automatically determines the appropriate Frame 
Controls attributes.

Â Custom:  This option allows you to manually adjust all of the attributes in the Frame 
Controls pane.

Late-Breaking News About Compressor 2 and Distributed Processing
The following news items are relevant if you are using Compressor with distributed 
processing. The Compressor 2 distributed processing feature is limited to computers 
that have either Final Cut Studio or DVD Studio Pro 4 installed.

Service Node Status Indicator in the Menu Bar 
By default, once a service node is enabled, an Apple Qmaster icon appears in the 
computer’s menu bar. The icon now changes color based on the service node’s 
current status:
Â Gray = Idle
Â Green = Processing
Â Red = Connection failure
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Click the icon to reveal additional information, including the service node’s IP 
address, port number, and capture status, as well as a link to the Apple Qmaster 
pane in System Preferences.

Cluster Storage Capacity
By default, the Apple Qmaster distributed processing system saves temporary process 
files in the /var/spool/qmaster directory on the startup disk of the cluster controller. 
Computers in the cluster will access this location as needed. If you are processing large 
source media files that exceed the available storage space on the startup disk, you may 
run out of storage space on that disk. There are a number of things you can do to 
address this.

If cluster storage capacity is low, do any of the following:
m Change the cluster storage location to a disk with more free space. For more 

information, see “Adjusting Cluster Storage Settings,” below.

m Configure cluster storage settings to delete files more frequently. For more information, 
see “Adjusting Cluster Storage Settings,” below.

m Compressor users can set Cluster Options preferences (Compressor > Preferences) to 
“Never copy source to cluster.” For more information, see the Compressor 2 User Manual.
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Adjusting Cluster Storage Settings
Follow the steps below to change scratch storage settings for a cluster. 

To change cluster storage settings:
1 On the cluster controller, open the Apple Qmaster pane in System Preferences.

2 If any Apple Qmaster services are enabled on this computer, click Stop Sharing to 
temporarily turn them off.

Note:  Do not attempt to change the cluster storage settings while the cluster is turned on.

3 Click Advanced to open the Advanced pane.

4 Do any of the following:

Â To change the cluster storage location:
Â Click the Set button next to the Cluster Storage field. 
Â Navigate to the folder in the dialog, select it, and then click Choose.

Â To change how often cluster storage files are deleted, enter a new number in the 
“Delete Files Older Than _ Days” field. 

5 Click the Start Sharing button to restart the cluster.

Click Set to open a dialog 
for choosing a new 
storage folder.

Click Stop Sharing to turn 
off the cluster before 
changing any settings.

Enter a new number to
change how often cluster

storage files are deleted.
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Cleaning Up Cluster Storage 
If you are using cluster storage, and an error occurs, partial files may be left on the 
designated cluster storage location. Check the designated cluster storage location to 
make sure no partial media files are left there. If you find partial media files, delete 
them and submit the job again.

QuickTime Reference Movies and Distributed Processing
Strictly speaking, only actual QuickTime movies (not QuickTime reference movies) are 
supported for distributed processing. If you submit a reference movie for distributed 
processing, make sure media files specified in the reference movie are available to each 
node of the Apple Qmaster cluster. In other words, put the media on the shared 
(cluster storage) volume.

Compressor Command-Line Usage Requires Login
While it is possible to use the command line to run an Apple Qmaster distributed 
processing network, each Compressor service node (each computer providing 
Compressor distributed processing services) must be logged in (with a Mac OS X 
user name and password) for full functionality.

Apple Qmaster Node Installer
By default, the Apple Qmaster Node Installer installs all the necessary Apple Qmaster 
software for distributed processing. (Insert the DVD Studio Pro 4 or the Final Cut Studio 
installation disc and locate the “AppleQmasterNode.mpkg” Installer package.) If you are 
installing the Apple Qmaster Node Installer on Mac OS X v10.3 Panther, do not deselect 
the “Apple Qmaster Support Software” option. Both Apple Qmaster Applications and 
Apple Qmaster Services require this software. For more information, see the 
Distributed Processing Setup guide.



 

Apple Qmaster Distributed Processing and Xsan
Using Apple Qmaster distributed processing on an Xsan may cause mounting 
problems when restarting an Apple Qmaster distributed processing cluster controller. 

Restart Apple Qmaster and Xsan computers in the following order:
1 Turn off the cluster controller by clicking Stop Sharing in the Apple Qmaster pane in 

System Preferences.

2 Restart the Apple Qmaster cluster controller computer.

3 Wait for the Xsan volume to mount on the desktop.

4 Click Start Sharing in the Apple Qmaster pane in System Preferences to restart 
the controller.

Distributed Processing and Network Interface Cards
In the Advanced section of the Apple Qmaster pane in System Preferences, you can 
restrict distributed processing activity to a particular network interface card by 
choosing it from the Use Network Interface pop-up menu. If you do this on a service 
node computer, use a different computer to submit Compressor jobs and batches.

Note:  If you choose a network interface card from the Use Network Interface pop-up 
menu, configure all nodes in the cluster to use the same network.

Wide Area Network Browsing
You can enable wide area network (WAN) browsing by selecting the “Allow wide area 
Bonjour in domain” checkbox in the Apple Qmaster pane in System Preferences. For 
more information about using WAN browsing with your distributed processing 
network, visit http://developer.apple.com/bonjour.
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